COMPUTER CAPSULE

Dear Readers,

We are presenting you the Computer Capsule. As per our commitments towards the needs of every student,

this capsule contains all the important facts and details that can be asked in the Upcoming Exams IBPS Exams. We
are starting this with the introduction of the Syllabus. Let us begin now :
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Syllabus of The Computer Section

Fundamentals of the Computer :

i) Hardware and Software

ii) Memory and Memory Units

iii) Number System

Internet

Microsoft Office (MS-Office)

Networking

DBMS (Database Management System)
Programming Languages

Full Forms/Abbreviations and Important Terms
Shortcut Keys

Miscellaneous (Latest in Computers and Mobile Technology)

Distribution Of Marks In IBPS Exams

1. Fundamentals
2. MS-Office
3. Full 16-17 Marks
Forms/Abbreviations
4. Important Terms
5. Shortcut Keys
6. Internet
7. Networking 3-4 Marks
8. DBMS
9. Programming
Languages

10. Miscellaneous




COMPUTER FUNDAMENTALS

A Computer is a general purpose device that can be
programmed to carry out a set of arithmetic or
logical operations automatically. Since a sequence
of operations can be readily changed, the computer
can solve more than one kind of problem.

A general purpose computer has four main
components: the arithmetic logic unit (ALU), the
control unit, the memory, and the input and output
devices (collectively termed 1/0).

The data that is fed into a computer processor
received into the computer by a keyboard or other
sources is called Input.

A computer is an electronic device that accepts data
from the user (input), processes the data by

performing calculations and operations on it and
generates the desired Output.

« The device which is used with a computer to display
or store data is called Peripherals.

+ The mechanical, magnetic, electronic and electrical
components that comprises a computer system
such as the Central Processing Unit (CPU), monitor,
keyboard, etc. is known as Hardware.

« A set of instructions that tells the computer about
the tasks to be performed and how these tasks are
to performed, is known as Software.

¢ An unprocessed collection or representation of raw
facts represented in a manner suitable for
communication, interpretation or processing by
humans or by automatic means, is known as Data.
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The result of processing, manipulating and
organising data in a way that adds to the knowledge
of the person receiving it, is known as Information.
The smallest unit of information, a computer can
understand and process, is known as Bit.

The primary goal of computer is to process
information that it receives and output the results.
The process of control and alter information is
known as Processing.

The number system computer used to store data and
perform calculation - Binary Number System.
Computer Speed, Accuracy, Diligence, Storage
Capability, Automation, Remembrance Power and
Versatility are the main Characteristics of
Computer.

Self Intelligence, Decision-Making power, Learning
power, Self care, Feelings are the Limitations of
Computer.

A mainframe computer is a much larger computer
that typically fills a room and may cost many
hundreds or thousands of times as much as a
personal computer. They are designed to perform
large numbers of calculations for governments and
large enterprises.

Read-only memory (ROM) is a storage medium
used in computers and other electronic devices. Data
stored in ROM can only be modified slowly or with
difficulty, or not at all.

ROM is non-volatile and the contents are retained
even after the power is switched off.

It only allows reading.

The types of ROM include PROM, EPROM and
EEPROM.

Random Access Memory (RAM),allows the
computer to store data for immediate for immediate
manipulation and to keep track of what is currently
being processed.

RAM is referred to as volatile memory and is lost
when the power is turned off.

It allows reading and writing.

The two main types of RAM are static RAM and
dynamic RAM.

SRAM retains data as long as power is provided to
the memory chip and need not be refreshed
periodically. SRAM stands for Static Random Access
Memory.

The data on DRAM continues to move in and out of
the memory as long as power is available and must
be continually refreshed to maintain the data. DRAM
stands for Dynamic Random Access Memory.
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Primary memory is computer memory that a
processor or computer accesses first or directly.

For example: RAM, and Cache Memory.

Secondary memory (or secondary storage) is the
slowest and cheapest form of memory. It cannot be
processed directly by the CPU.

Secondary memory devices include magnetic disks
like hard drives and floppy disks, optical disks such
as CDs and CDROMs, and magnetic tapes, which were
the first forms of secondary memory.

Virtual memory is memory on the hard disk that
the CPU uses as an extended RAM.

Installation is the process of copying software
programs from secondary storage media to the hard
disk.

A central computer that holds collections of data and
programs for many PCs, workstations and other
computers is a Server.




BASIC ORGANIZATION OF A COMPUTER SYSTEM
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ARITHMETIC LOGIC

An Arithmetic Logic Unit (ALU) is a digital circuit
that performs integer arithmetic and logical
operations. The ALU is a fundamental building block
of the central processing unit of a computer.

Control Unit is responsible for controlling the
overall operations of computer. It coordinates the
sequence of execution of instructions and controls
the overall functioning of the computer.

The first computer architecture was introduced by
John Von Neumann (1970)

Personal computers use a number of chips mounted
on a main circuit board called Motherboard.

The CPU is fabricated as a single Integrated Circuit
(IC) chip. It is also known as the Microprocessor.
Multiprocessing is the use of two or more central
processing units (CPUs) within a single computer
system. The term also refers to the ability of a system
to support more than one processor and/or the
ability to allocate tasks between them.

The organization and interconnection of the various
components of a computer system is known as
Computer Architecture.

A CPU can directly understand the Machine
Language.

An input device is any peripheral (piece of
computer hardware equipment) used to provide
data and control signals to a computer. They are the
devices that feed data into a computer.

Examples of input devices include keyboards, mouse,
scanners, digital cameras and joysticks.

The keys include the letter keys (0, 1, 2, ..., 9; A, B, Z),
which are generally laid out in the same style as in
typewriters are known as Alphanumeric Keys.
'Caps lock' and 'Num lock' keys are called as Toggle
Keys because when pressed, they change their status
from one state to another.

Numeric Keypad is a keypad located on the right
hand side of the keyboard. It consists of digits and
mathematical operators.

A Modifier key is a special key (or combination) on
a computer keyboard that temporarily modifies the
normal action of another key when pressed together.
By themselves, modifier keys usually do nothing;
that is, pressing any of the Shift, Alt, or Ctrl keys
alone does not (generally) trigger any action from
the computer.

A Mouse is the most popular input device which is
used today for interactive processing and for the one
line entry of data for batch processing.

Drag and Drop refers to the action of clicking and
holding down the mouse button, while moving the
mouse and then releasing the mouse button.

The first computer mouse was invented by Douglas
Engelbart.

Joystick is the device that moves in all directions
and controls the movement of a pointer.

A Touch Screen is a type of display screen device
that is placed on the computer monitor to allow
direct selection or activation of the computer when
the user touches the screen.

Light Pen is the pen shaped device, which can sense
light and is used to point at spots on a video screen.
A technology enables a high-speed reading of large
quantities of data and transferring these data to the
computer without using a keyboard. It is referred as
Optical Mark Reader (OMR).

[t uses a beam of light that is reflected on the paper
with marks, to capture presence and absence of
marks.

MICR reads the characters by examining their shapes
in a matrix form and the information is then passed
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“on to the computer. MICR stands for Magnetic Ink
Character Reader.

It provides a high level of security and is therefore
used by the banking industry for faster processing of
the cheques

It is a machine readable code, which is represented
by parallel vertical lines with varying widths. For
reading these bar-coded data, a device is used, which
is known as a Bar Code Reader (BCR)

Optical Character Recognition (OCR) is used to
scan the document containing text.

It is the mechanical or electronic conversion of
scanned or photographed images of typewritten or
printed text into machine-encoded/computer-
readable text.

A keyboard is a typewriter-style device, which uses
an arrangement of buttons or keys, to act as
mechanical levers or electronic switches.

Most of the commonly available personal computers
have a keyboard, popularly known as Qwerty.

The keys labeled F1 to F12 on the keyboard are called
Function Keys.

An output device is any piece of computer hardware
equipment used to communicate the results of data
processing carried out by an information processing
system (such as a computer) which converts the
electronically generated information into human-
readable form

The printed form of output is referred as Hard Copy.
The form of output displayed on the screen is
referred as Soft Copy.

The device that prints information from the
computer onto the paper is Printer.

Pages Per Minute (PPM) is the unit used to count
the speed of the printer.

On the basis of technology, printers are categorized
into Impact and Non- Impact Printers.

Impact printers create an image by using some
mechanism to physically press an inked ribbon

against the page, causing the ink to be deposited on
the page in the shape desired.

Examples of Impact Printers are Character
Printers and Dot Matrix Printers.

Non - Impact Printers do not touch the paper when
creating an image.

Examples of Non - Impact Printers are Inkjet
printers, Laser printers, Solid ink printers, Dye-
sublimation, Thermal wax printers, Thermal auto
chrome printers.

A pen based output device, attached to a computer
for making vector graphics, that is, images created by
a series of many straight lines is known as Plotters.
The number of pixels displayed on a screen is known
as Resolution.

A Monitor is a TV-like display attached to the
computer on which the output can be displayed and
viewed. It can either be a monochrome display or a
colour display.

The set of instructions, which control the sequence
of operations, are known as Program. Itis a
sequence of instructions, written to perform a
specified task with a computer.

A Software instructs the computer what to do and
how to do it. It is a set of instructions that tells the
computer about the tasks to be performed and how
these tasks are to performed.

One or more defects or problems that prevent the
software from working as intended of working at all
are called Bug.

Software that contributes to the control and
performance of the computer system and permits
the user to use the system more conveniently is
termed as System Software.

Antivirus Software is used to scan the hard disk to
remove the virus from them.

The assembly language program is translated into
machine code by a separate program known as an
Assembler.

A Backup, or the process of backing up, refers to the
copying and archiving of computer data so it may be
used to restore the original after a data loss event. It
contains a copy of every program data and system
file on a computer.

An Operating System controls the way in which the
computer system functions and provides a means by
which users can interact with the computer.

Loading of the Operating System is known as
Booting. Restarting a computerthat is already on, is
referred to as Warm Booting.

Basic Input - Output System (BIOS) is the part of
operating system that manages the essential
peripherals such as the keyboard, screen, disk drives
and parallel and serial ports.




An Integrated Software is a single application that
combines major features of several types of
application.

An Application Software is the program that makes
the computer useful to the users.

Computer hardware is the collection of physical
elements that constitutes a computer system.
Computer hardware refers to the physical parts or
components of a computer such as the monitor,
mouse, keyboard, computer data storage, hard drive
disk (HDD), system unit (graphic cards, sound cards,
memory, motherboard and chips), etc. all of which
are physical objects that can be touched.
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The motherboard is the main component of
computer. It is a large rectangular board with
integrated circuitry that connects the other parts of
the computer including the CPU, the RAM, the disk
drives(CD, DVD, hard disk, or any others) as well as
any peripherals connected via the ports or the
expansion slots.

Primary Secondary (Auxiliary)
/Memory ™~ Memory
Ca‘(;he ~h Main (1) Magnetic Tape
Memory / Memory (Sequenbal Access) _HDD
(CUP Registers) / 2 (2) Magnetic Disk < (Hard Disk Drive)
RAM ROM NG
A (Read Only :
(Random Access Memory) _ = (3) Optical Disk (Floppy Disk Drive)
Memory) ( ?
e e~ - PRON o +—CD (700 MB)
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e Memory Units:

4 bit 1 nibble

8 bit 1 byte
1024 B 1 KB (Kilo Byte)
1024 KB 1 MB (Mega Byte)
1024 MB 1 GB (Giga Byte)
1024 GB 1 TB (Tera Byte)
1024 TB 1 PB (Peta Byte)
1024 PB 1 XB (Exa Byte)
1024 XB 1 ZB (Zeta Byte)
1024 ZB 1 YB (Yota Byte)
bit (b)
Byte (B)

s R

The number system, the modern computers are
operated - Binary Number System(0's and 1's)

Name the most significant bit, which represent 1
and O for a positive number and negative number,
respectively - Sign Bit

Which coding scheme represents data in a binary
form in the computer system? ASCII, EBCDIC and
Unicode are the most commonly used codes under
this scheme - Binary Coding Scheme

EBCDIC is a 8-Bit code with 256 different
representations of characters. It is mainly used in
mainframe computers.

EBCDIC stands for - Extended Binary Coded
Decimal Interchange Code

BCD is a method that represents the decimal digits
with the help of binary digits. It takes advantage
that one decimal numeral can be represented by 4-
bit pattern. BCD stands for Binary Coded Decimal
This coding system is used to represent the interval
storage area of the computers. In this system, every
character is represented by a combination of bits.
Binary Coding System




The Base or Radix of the decimal number system is
10
The standard code the computer industry created to
represent characters - American Standard Code
for Information Interchange (ASCII)
ASCII is a code used for standardizing the
storage and transfer of information amongst
various computing devices.
It is required for representing more than 64
characters. At present, the mostly used coding
systems are ASCII and EBCDIC
The code is also known as Reflected Code - Gray
Code

Number System

R/
0’0

A Cursor is an indicator used to show the position
on a computer monitor or other display device that
will respond to input from a text input or pointing

device.

Basic Keys (Common Tasks

Ctrl + Shift + Create a non breaking space
Spacebar

Ctrl + B Make letters bold

Ctrl + 1 Make letters italic

Ctrl + U Make letters underline

Ctrl + Shift+ < Decrease font size one value
Ctrl + Shift + > Increase the font size one value
Ctrl + [ Increase the font size by 1 point
Ctrl +] Decrease the font size by 1 point
Ctrl + Remove paragraph or character
Spacebar formatting.

Decimal, Binary, Octal and Hexadecimal Equivalents Ctrl + C

Decimal Binary Octal Hexadecimal
0 0000 000 0
1 0001 001 1
2 0010 002 2
3 0011 003 3
4 0100 004 4
5 0101 005 5
6 0110 006 6
7 0111 007 7
8 1000 010 8
9 1001 011 9
10 1010 012 A
11 1011 013 B
12 1100 014 C
13 1101 015 D
14 1110 016 E
15 1111 017 F

MICROSOFT OFFICE

Microsoft Office is an office suite of desktop
applications, servers and services for the Microsoft
Windows and OS X operating systems. It was first
announced by Bill Gates of Microsoft on August 1,
1988 at COMDEX in Las Vegas.

MS office primarily includes Word, Excel,
PowerPoint, Access and Outlook. It also includes
OneNote, Groove, InfoPath and Publisher.

MS WORD
Microsoft Word is a word processor developed by
Microsoft.
It is used for creating, editing, formatting, storing,
retrieving and printing of a text document.
Microsoft Word's native file formats are denoted
either by a .doc or .docx file extension.

Copy the selected text or object

Ctrl + X Cut the selected text or object
Ctrl+V Paste text or an object

Ctrl + Alt+V Paste special

Ctrl + Shift + V Paste formatting only

Ctrl + Z Undo the last action

Ctrl +Y Redo the last action

menu.

% To create a document, we use New command at the

Save as is used to save a document for the first
time. It is also used to change the destination of the
saved file in the computer.

Print Preview is used to see the document before
the printout is taken.

Cut and Paste options are used to move the data
from one part of the document to another.




Ctrl+F10
Ctrl+F11
Ctrl+F12
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Choose the print preview
command (Microsoft office Button)

Ctrl+F3 Cut on the spike
Ctrl+F4
Ctrl+F6

Ctr Insert an empty field

Close the window
Go to the next window

Maximise the document window
Lock a field

Choose the Open
(Microsoft Office Button)

command

+ Portrait and Landscape options are available
in Orientation category of Page Setup.

« Alignment refers to the position of text
between the margins.

« Auto complete is a feature in word that

automatically completes the spelling of days of

the week and months of the year that have

more than five letters in their names.

Function Keys

Get help or visit Microsoft office Online.
Move text or graphic.

Repeat the last action

Choose the Go To command (Home tab).
Go to the nest pane or frame.

Choose the spelling command (Review
tab)

Extend a selection

Update the selected fields

Show key tips

Go to the nest field

Choose the Save As command
(Microsoft Office Button).

Header and Footer option is used to display
information such as title and page number of the
document.

The bar at the top of the window that bears the
name of the window, is known as Title Bar.

A screen element of MS Word that is usually
located below the title bar that provides
categorisedoption, is called Menu Bar.

Auto Correct in word automatically corrects
certain spelling, typing, capitalisation or grammar
errors.

Thesaurus is used for finding a synonym for a
word in the document.

Word has extensive lists of bullets and

numbering features used for tables, lists, pages,

chapters, headers, footnotes, and tables of content.
MS EXCEL

Microsoft Excel is a spreadsheet application

developed by Microsoft for Microsoft Windows

and Mac OS.

[t features calculation, graphing tools, pivot tables,

and a macro programming language called Visual

Basic for Applications.

The intersection of a row and column is called a

Cell.

The cell in which we are currently working is

known as Active Cell.

Microsoft Excel's native file formats are denoted

either by a .xls or xlsx file extension.

A Worksheet is made of columns and rows,

wherein columns run Vertically and rows run

Horizontally.

Up to Excel 2003, the standard amount of columns

has been 256 and 65,536 rows.

Excel 2007 onwards, the maximum number of

rows per worksheet increased to 1,048,576 and

the number of columns increased to 16,384.

Microsoft Excel has the basic features of all

spreadsheets, using a grid of cells arranged in

numbered rows and letter-named columns to

organize data manipulations like arithmetic

operations

The letter and number of the intersecting column

and row is the Cell Address.

Short cut key to insert a new worksheet in MS-

Excel is ALT + Shift + F1 + or F11.

Sheet tab is the tab at the bottom of the worksheet

window that displays the name of the worksheet.

A Microsoft office document that contains one or

more worksheets is known as a Workbook.




Shortcut Keys of MS-Excel

Key Description

F2 Edit the selected cell

F5 Go to a specific cell

F7 Spell check selected text and/or
document

F11 Create chart

Ctrl + Shift +;  Enter the current time

Ctrl +; Enter the current date

Shift + F3 Open the Excel formula window

Shift + F5 Bring up search box.

Ctrl+A Select all contents of the worksheet

Ctrl + B Bold highlighted selection

Ctrl +1 Italic highlighted selection

Ctrl+U Underline highlighted selection

Ctrl + P Bring up the print dialog box to
begin printing

Ctrl+Z Undo last action

Ctrl + F9 Minimise current workbook

Ctrl + F10 Maximise currently selected
workbook

Ctrl + F6 Switch between open
workbooks/window

Ctrl + pageup Move between Excel worksheet in
the same Excel document.

Ctrl + Page Move between Excel worksheets in

Down the same Excel document

Ctrl + Tab Move between two or more open
Excel files

Alt + = Create a formula to sum all of the
above cells

Ctrl +° Insert the value of the above cell

into cell currently selected.

Ctrl + Arrow Move to next section to text

key

Ctrl + Space Select entire column
Shift + Select entire row
Space

Important Questions Based on Microsoft
Word:

1. Pressing F8 key for three times selects
A) Aword B) A sentence
C) A paragraph D) Entire document

2. What happens if you press Ctrl + Shift + F8?

A) It activates extended selection

B) It activates the rectangular selection

C) It selects the paragraph on which the insertion line
is.

D) None of above

3. How can you disable extended selection mode?
A) Press F8 again to disable

B) Press Del to disable

C) Press Esc to disable

D) Press Enter to disable

4. What does EXT indicator on status bar of MS
Word indicate?

A) It indicates whether the external text is pasted on
document or not

B) It indicates whether extended add-ons are
installed on MS Word or not

C) It indicates whether Extended Selection mode is
turned on or off

D) None of above

5. What is the maximum number of lines you can
set for a drop cap?

A)3 B) 10 C)15 D) 20

6. What is the default number of lines to drop for
drop cap?

A)3 B) 10 C)15 D)20

7. What is the shortcut key you can press to
create a copyright symbol?

A) Alt+Ctrl+C B) Alt+ C

C)Ctrl+C D) Ctrl + Shift + C

8. How many columns can you insert in a word
document in maximum?
A) 35 B) 45 C)55 D)65

9. What is the smallest and largest font size
available in Font Size tool on formatting toolbar?
A)8and 72 B) 8 and 64

C)12and 72 D) None of above

10. What is the maximum font size you can apply
for any character?

A) 163 B) 1638

C) 16038 D) None of above

11. Which of the following is graphics solution for
Word Processors?
A) Clipart

C) Drop Cap

B) WordArt
D) All of above

12. The keystrokes Ctrl + I is used to
A) Increase font size
B) Inserts a line break




C) Indicate the text should be bold
D) Applies italic format to selected text

13. A character that is raised and smaller above
the baseline is known as

A) Outlined B) Raised

C) Superscript D) Subscript

14. What is the purpose of inserting header and
footer in document?

A) To enhance the overall appearance of the
document

B) To mark the starting and ending of page

C) To make large document more readable

D) To allow page headers and footers appear on
document when printed

15. Which of the following function key activates
the speller?

A) F5 B) F7

C) F9 D) Shift + F7

16. The minimum number of rows and columns in
MS Word document is

A)land]l1 B)2and 1

C)2and?2 D) None of above

17. Thesaurus tool in MS Word is used for

A) Spelling suggestions B) Grammar options
C) Synonyms and Antonyms words

D) All of above

18. Why Drop Caps are used in document?

A) To drop all the capital letters

B) To automatically begin each paragraph with
capital letter

C) To begin a paragraph with a large dropped initial
capital letter

D) None of above

19. A bookmark is an item or location in
document that you identify as a name for future
reference. Which of the following task is
accomplished by using bookmarks?

A) To add anchors in web page

B) To mark the ending of a paragraph of document

C) To quickly jump to specific location in document

D) To add hyperlinks in webpage

20. A word processor would most likely be used
todo
A) Keep an account of money spent

B) Do a computer search in media center
() Maintain an inventory
D) Type a biography

21. Which of the following is not valid version of
MS Office?

A) Office XP
C) Office 2007

B) Office Vista
D) None of above

22.You cannot close MS Word application by
A) Choosing File menu then Exit submenu

B) Press Alt+F4

C) Click X button on title bar

D) From File menu choose Close submenu

23. The key F12 opens a
A) Save As dialog box B) Open dialog box
C) Save dialog box D) Close dialog box

24. What is the short cut key to open the Open
dialog box?

A)F12 B) Shift F12

C) Alt + F12 D) Ctrl + F12

25. A feature of MS Word that saves the document
automatically after certain interval is available
on

A) Save tab on Options dialog box

B) Save As dialog box
C) Both of above D) None of above

26. Where can you find the horizontal split bar on
MS Word screen?

A) On the left of horizontal scroll bar

B) On the right of horizontal scroll bar

C) On the top of vertical scroll bar




D) On the bottom of vertical scroll bar

27. Which of the following is not available on the
Ruler of MS Word screen?

A) Tab stop box B) Left Indent

C) Right Indent D) Center Indent

E) All of them are available on ruler

28. What is place to the left of horizontal scroll
bar?

A) Tab stop buttons  B) View buttons

C) Split buttons D) Indicators

E) None of above

29. Which file starts MS Word?
A) Winword.exe B) Word.exe
C) Msword.exe D) Word2003.exe

30. How many ways you can save a document?
A)3 B)4 C(C)5 D)6

31. If you want to keep track of different editions
of a document which features will you use?

A) Editions B) Versions

C) Track Change D) All of above

32. Background color or effects applied on a
document is not visible in
A) Web layout view

C) Reading View

B) Print Layout view
D) Print Preview

33. What is a portion of a document in which you
set certain page formatting options?
A) Page B) Document

C) Section D) Page Setup

34. Borders can be applied to

A) Cells B) Paragraph

C) Text D) All of above

35. Which of the following is not a type of page
margin?

A) Left B) Right

C) Center D) Top

36. What is the default left margin in Word 2003
document?

A)1" B) 1.25" C)1.5" D) 2"

37. What is gutter margin?

A) Margin that is added to the left margin when
printing

B) Margin that is added to right margin when
printing

C) Margin that is added to the binding side of page
when printing

D) Margin that is added to the outside of the page
when printing

38. Portrait and Landscape are
A) Page Orientation  B) Paper Size
C) Page Layout D) All of above

39. If you need to change the typeface of a
document, which menu will you choose?

A) Edit B) View

C) Format D) Tools

40. Which of the following is not a font style?
A) Bold B) Italics
C) Regular D) Superscript

41. What happens when you click on Insert >>
Picture >> Clip Art

A) It inserts a clipart picture into document

B) It lets you choose clipart to insert into document
C) It opens Clip Art taskbar

D) None of above

42. Which option is not available in Insert Table
Auto fit behavior?

A) Fixed Column Width
C) Autofit to Window

B) AutoFit to Contents
D) Autofit to Column

43. To autofit the width of column

A) Double click the right border of column
B) Double click the left border of column
C) Double click the column header

D) All of above

44. From which menu you can insert Header and
Footer?

A) Insert Menu
C) Format menu

B) View Menu
D) Tools Menu

45. After typing header text, how can you quickly
enter footer text?

A) Press PageDown key and type the text for footer
B) Click on Switch between Heder & Footer then type
the text

C) Both of above D) None of above




46. When inserting Page number in footer it
appeared 1 but you wish to show a. How can you
do that?

A) From format menu choose bullets and Numbering
and configure necessary setting

B) From Insert menu choose Page Number and
specify necessary setting

C) Click on Page Number Format tool and specify
required setting

D) All of above

47. Which of the following statement is false?

A) You can set different header footer for even and
odd pages

B) You can set different page number formats for
different sections

C) You can set different header footer for first page of
a section

D) You can set different header and footer for last page
of a section

48. Where can you change the vertical alignment?
A) Formatting toolbar
B) Paragraph dialog box
C) Page Setup dialog box D) Standard toolbar
49. To get to the ‘Symbol’ dialog box, click on the
____menu and choose ‘Symbol’.

A) Insert B) Format

C) Tools D) Table

50. Which of the following symbol sets would be
most likely to contain a mathematical symbol
such as a degree sign, greater than or equal to, or
a Greek letter?
A) Wingdings
C) Webdings

B) Wingdings 3
D) Symbol

51. When assigning a shortcut key to a symbol,
you should always try to select a key or key
combination that is:

A) unassigned

B) Located on the ten-key pad section of your
keyboard.

C) Assigned to another task.

D) From the same font family as the symbol.

52. Suppose you wanted to create an AutoCorrect
entry that would type the words ‘We regret to
inform you that your submission has been

declined’ Of the following choices, which would
be the best name you could assign to this entry?
A) Regret B) Subdual

C) We regret to inform you that your submission has
been declined

D) 11

53. If you want to convert a symbol or several
lines of text into an AutoCorrect entry, you
should:

A) Insert the symbol or type the text in a Word
document first. Then, select the text or symbol and go
to the AutoCorrect dialog box.

B) Click the Tools menu and choose AutoCorrect
Options. Then, click the Insert menu and choose
Symbol (or click the Format menu and choose
Paragraph) to add the symbol or paragraph to
AutoCorrect.

C) AutoCorrect can only accommodate one line of
text. It is not possible to convert a symbol or multiple
lines of text into an AutoCorrect entry.

D) Insert the symbol or type the text in a Word
document first. Then, select the text or symbol and
click the Edit menu followed by Paste Special. Select
New AutoCorrect Entry and then click OK.

54. AutoCorrect was originally designed to

replace words as you type.
A) Short, repetitive ~ B) Grammatically incorrect
C) Misspelled D) None of the above

55. Which of the following is the second step in
creating a macro?

A) Start recording

B) Using your mouse or keyboard, perform the task
you want to automate

C) Assign a keyboard shortcut to the macro

D) Give the macro a name

56. If you will be displaying or printing your
document on another computer, you’ll want to
make sure and select the option under
the ‘Save’ tab.

A) Embed Fonts B) Embed True Type Fonts
C) Save True Type Fonts D) Save Fonts

57. In Word, the mailing list is known as the

A) Data sheet
C) Data source

B) Source
D) Sheet




58. Which of the following is not one of the three
‘Mail Merge Helper’ steps?

A) Merge the two files

B) Create the main document

C) Set the mailing list parameters

D) Create the data source

59. Which of the following button will allow you
to add, delete, or change records in your Data
Source?

A) ‘Data Source’ button

C) ‘Edit Data Source’ button
D) ‘Data editing’ button

B) ‘Edit’ button

60. It is possible to a data source before
performing a merge.

A) Create B) Modify

C) Sort D) all of the above

61. What is the default font size of a new Word
document based on Normal template?

A) 10 pt B) 12 pt

C) 14 pt D) None of above

62. What is the default font used in MS Word
document?

A) Times New Roman B) Arial

C) Algerian D) Preeti

63. Which tab in Font dialog box contains options
to apply font effects?
A) Font tab

C) Text Effects

B) Character Spacing
D) Standard Toolbar

64. If you need to double underline a word, how
will you do that?

A) Go to Format menu and then Font option. Open
Underline Style and choose Double Underline

B) From Format menu choose Font option and then
from Font tab open Underline Style and select Double
Underline

C) Select the text then choose Format >> Font and on
Font tab open Underline Style and choose Double
Underline

D) Click double underline tool on formatting toolbar

65. DropCap means
A) All Caps
C) Title case

B) Small Caps
D) None of above

66. What is the short cut key to open Font dialog
box?

A) Ctrl + F B) Alt + Ctrl + F
C)Ctrl+D D) Ctrl + Shift + D

67. How can you access the font size tool on
formatting toolbar?

A) Ctrl +S B) Ctrl + Shift + S

C) Ctrl + P D) Ctrl + Shift + P

68. How can you make the selected character
superscripted?

A) Ctrl + = B) Ctrl + Shift + =

C) Alt + Ctrl + Shift + = D) None of above

69. What does Ctrl + = key effect?

A) Superscript B) Subscript

C) All Caps D) Shadow

70. What happens if you mark on Hidden check
box of Font dialog box after you select some text?
A) The text is deleted from document and you need to
bring from Recycle Bin if required again.

B) The text is hidden and you need to bring it by
removing the check box if needed again

C) The text is deleted and cannot be returned back

D) The text is hidden and cannot be returned back

71. How can you increase the font size of selected
text by one point every time?

A) By pressing Ctrl + ] B) By pressing Ctrl + |

C) By pressing Ctrl + } D) By pressing Ctrl + {

72. Which of the following line spacing is invalid?
A) Single B) Double
C) Triple D) Multiple

73. How can you apply exactly the same
formatting you did to another text?




A) Copy the text and paste in new location. Then type
the new text again.

B) Copy the text and click on Paste Special tool on
new place

C) Select the text then click on Format Painter and
select the new text

D) All of above

74. What should you do if you require pasting the
same format in many places?

A) Click the Format painter and go on pasting in
many places holding Alt Key

B) Double click the format painter then go on pasting
in many places

C) Click the format painter then go on pasting to
many places holding Ctrl Key

D) All of above

75. On which toolbar can you find Format Painter
tool?

A) Standard toolbar
C) Drawing Toolbar

B) Formatting toolbar
D) Picture Toolbar

76. Which indent marker controls all the lines
except first line?

A) First Line Indent Marker

B) Left Indent Marker

C) Hanging Indent Marker

D) Right Indent Marker

77. How can you remove tab stop markers from
ruler?

A) Double click the tab marker and choose Clear All
B) Drag the tab stop marker out of the ruler

C) Right click the tab stop marker and choose remove
D) All of above

78. Which operation you will perform if you need
to move a block of text?

A) Copy and Paste
C) Paste and Delete

B) Cut and Paste
D) Paste and Cut

79. What is the extension of Word files?
A) FIL B) DOT
C) bocC D) TXT

80. Which of the following option is not available
in Insert >> Picture?
A) Chart

C) Clip Art

B) Word Art
D) Graph

INTERNET

The Internet is a global system of
interconnected computer networks that use the
standard Internet protocol suite (TCP/IP) to
link several billion devices worldwide.
It is a network of networks that consists of
millions of private, public, academic, business,
and government networks, of local to global
scope, that are linked by a broad array of
electronic, wireless, and optical networking
technologies.
The World Wide Web (abbreviated as WWW
or W3, commonly known as the Web) is a
system of interlinked hypertext documents that
are accessed via the Internet.
A Website, is a set of related web pages served
from a single web domain.
A Home page, index page, or main page is a
page on a website. A home page usually refers
to:

The initial or main web page of a website,

sometimes called the "front page" (by analogy

with newspapers).




o The first page that appears upon opening a
web browser program, which is also
sometimes called the start page. This 'start
page' can be a website or it can be a page with
various browser functions such as the visual
display of websites that are often visited in
the web browser.

e The web page or local file that automatically
loads when a web browser starts or when the
browser's "home" button is pressed; this is
also called a "home page". The user can
specify the URL of the page to be loaded, or
alternatively choose e.g. to re-load the most
recent web page browsed.

e A personal web page, for example at a web
hosting service or a university web site, that
typically is stored in the home directory of the
user.

A Hyperlink is a reference to data that the reader
can directly follow either by clicking or by hovering
or that is followed automatically
A web browser (commonly referred to as a
browser) is a software application for retrieving,
presenting and traversing information resources on
the World Wide Web.
Some of the famous browsers are Safari, Chrome,
Firefox, Bolt, UC Browser and Internet Explorer
The Uniform Resource Locator, abbreviated as
URL is a specific character string that constitutes a
reference to a resource. In most web browsers, the
URL of a web page is displayed on top inside an
address bar.

(i) An example of a typical URL would be

"http://www.bankersadda.com".
Downloading means to receive data to a local
system from a remote system, or to initiate such a
data transfer
Uploading refers to the sending of data from a local
system to a remote system such as a server or
another client with the intent that the remote
system should store a copy of the data being
transferred
An Internet Protocol address (also known as an
IP address) is a numerical label assigned to each
device (e.g., computer, printer) participating in a
computer network. It acts as an identifier for a
computer. It is a unique address for every
computer.
An email attachment is a computer file sent along
with an email message. One or more files can be
attached to any email message, and be sent along
with it to the recipient.

«» Hotmail was co - founded by an Indian American
entrepreneur Sabeer Bhatia along with Jack Smith
in July of 1996

« CC(Carbon Copy) in e - mail indicates those who
are to receive a copy of a message addressed
primarily to another. The list of CCed recipients is
visible to all other recipients of the message.

« An additional BCC (blind carbon copy) field is
available for hidden notification; recipients listed in
the BCC field receive a copy of the message, but are
not shown on any other recipient's copy (including
other BCC recipients)

+ The Drafts folder retains copies of messages that
you have started but are not yet ready to send.

« The first email was sent by Ray Tomlinson to
himself in 1971.

DATA COMMUNICATION & NETWORKING

+ Data Communication deals with the transmission
of digital data from one device to another. Data is
transferred through a pathway called as
communication channel which can be physical wire
connecting the devices or may be unguided media
like laser, microwave etc.

s A communication channel has a source or
transmitter at one side and a designation or
receiver at another side